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ABSTRACT

This project is focused on the development of PLC supervisory control system to
control and remotely monitor a batch blending process in lubricant blending plant.
Object Linking and Embedding for Process Control (OPC) is used as a standard
interface between PL.C and LabVI_EW’s remote monitoring tool. The interface used
Microsoft’s Component Object Model (COM) to interact and permit a protocol for
reai-time information exchange bétween LabVIEW and PLC via a RS-232 serial
cable. The aim of this project is té create a reliable remote monitoring system with
user-friendly interface. The superviisory conirol system can improve plant’s operation
efficiency by providing the overvie{w process and control capability from the monitor
inside control room. It also helps to reduce risk instde plant as operator can have
their job done remotely inside control room. Furthermore, this project offers an
alternative and cheaper supervisory solution for batch processes compared to
distributed control system (DCS).
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CHAPTER 1

INTRODUCTION

1.1 Background Of Study

Lubetech Sdn Bhd is a lubricant blending plant located in Shah Alam. Its
operation covers blending various grades of lubricant inside blending kettles by

batch. This plant operated semi-automatically using Programmable Logic Controller
(PLC) without supervisory control software.

This project will focus on development of PLC remote monitoring for
lubricant blending process plant. PLC is an industrial computer used for automation
processes. This controller has the ability to interact with digital and analog devices
and was also designed to withstand industrial environment such as extreme
temperature, excessive vibration, electrical noise and impact. This project utilized the
OMRON CQMIH CPU21 PLC as a controller for the plant due to the availability of
the hardware.

Various methods can be use to communicate between PLC and the host-
computer such as 9-pin RS-232 serial connector, E1IA-485 serial connector and RJ-45
modular connector. This project will concentrate on RS-232 serial connection port to
communicate with LabVIEW remote monitoring application using Object Linking
and Embedding for Process Control (OPC) protocol.



1.2 Problem Statement

In Lubetech plant, PL.C was used as an interlocking system for quality control
and safety procedure. An interlocking system in Lubetech prevents different grades
of lubricant from mixing up during transferring and blending process. Before
transferring process started, Lubetech personnel have to travel inside the plant, check
the specific hand valve opening and manually open or close the valves accordingly.

Transferring process will only be started if the correct valves are opened and closed.

1.3 Problem Identification

The routine activity of Lubetech personnel manually checking and open/close
valve will cause delay time before transferring and blending process can start. In
addition, they are exposed to loud noises, chemical fumes and many more hazards
inside plant. The remote monitoring can provide remote access for personnel to
open/close valves without exposing themselves to these hazards. Furthermore,

supervising and controlling valve in remote room can save time.

1.4 Objective & Scope of Study

The objectives of this project are:
i.  To develop supervisory control for tubricant biending process.
ii. To communicate PLC with LabVIEW supervisory conirol.
iii. To reduce time delay of lubricant transferring process.

The scope of study of this project will be supervisory control for lubricant
blending process using PLC. This project is unique to lubricant blending process for
UMW Lubetech Sdn Bhd. OMRON CQM1H CPU21 PLC is chosen as a controiler
for the plant due to the availability of the hardware.

Beside that, LabVIEW software will be used to create the remote monitoring
interface. LabVIEW commonly use for data acquisition, instrument control, and
automation in industry will be used to develop user graphical interface (GUI) for
PLC supervisory control.



CHAPTER 2

LITERATURE REVIEW

Lubricant business nowadays expanding swiftly aided by rapid
industrialization and rising car ownership rate. Green Planet Group reported that
global lubricant demand is forecast to reach 40.5 million metric tons in 2012 (Green
Planet Group, 2011). In this case, automation process that plays an important role in

lubricant manufacturing process should be advancing as well.

2.1 Programmable Logic Controller

A programmable logic controller (PLC) is an industrial computer that uses
programmable memory to store instructions and to implement specific functions such
as logic, sequencing, timing, counting and arithmetic in order to control machines or
processes (National Electrical Manufacturers Association, 2003). It has been
developed since 1960s and initially it was used to replace hard-wired relay control
logic system. Nowadays, PLC is widely used in factories and industries to handle
their automated system because of its reliability, flexibility and robust design for

industrial environment.

Basic component of PLC consist of Central Processing Unit (CPU), power
supply unit, memory and input/output modules.

The CPU executes program instructions and handles the interaction with
other component of the system. CPU can be configured either in program mode or
run mode. In program mode, user program can be uploaded into the PLC and if all
input and output signals are wired to the PLC terminals, the CPU can be put in run

mode 1o start scanning and executing ladder logic continuously.



Power supply of the PLC distributes various ranges of AC and DC voltages
to CPU and PLC components. Usually, power supply does not provide power to
external devices connected to PLC. Separate power supplies are needed to power the
external inputs and outputs (Stenerson, 2003). However, some small-sized PLC does

have internal supply power to power up the inputs.

The memory unit of PLC stores controt actions of controller and input data

for processing and for the output.

The input/output (I/O) modules are where the PLC received signal from
external devices and send instruction to external devices (Bolton, 2009). Common
input devices are switches and sensors while the output devices can be motor starter,
lights, coils and valves. Beside received and transmit signal to external devices, 11O
modules also help to protect and isolate CPU from outside world. This is typically
done by optical isolation. The PLC CPU and external devices are not connected
literally, means that there is no electrical connection between the two (Stenerson,
2003). The CPU and external devices are separated optically. When triggered, input
devices will send signal that turns on the light inside input module, and the receiver
will capture the light. Receiver will turns on and send signal to the CPU to be

processed.

2.2 Ladder Logic Programming

Ladder diagram is one of the common methods to program PLC for industrial
automation. Engineers, technicians and maintenance electricians will use the
programming language of a PLC. Therefore, the programming language should be
based on techniques used in industry rather than technique used in computer
programming (Parr, 2003). This programming method resembles a ladder, with two
vertical lines called power rails connected by a horizontal line called rung. The term
rung is invariably applied to the contacts leading to one output (Parr, 2003). Each

rung must starts with at least one input and ends with at least one output.



The input of the PLC in ladder diagram is called contact (relay contact) while
the output is called coil (relay coil). The input can be normally open (NO) or
normally closed (NC) based on user configuration. A NO input is representing open
switch at initial condition and will be close if external force was applied. A NC input
is representing closed switch at initial condition and will be open if external force

was applied.

In the run mode, ladder diagram is read from left to right of the rung and
from top to bottom of the ladder. When all the rungs are scanned and reached end
rung, the PL.C will go'back to the first rung and repeat the process. This procedure of
going through all rungs is termed as a cycle (Bolton, 2009).

2.3 Supervisory Control

Human Machine Interaction (HMI) is defines as the study of interaction
between people and computers (Lalanne & Kohlas, 2009). For this supervisory
control project, HMI is implemented between PLC and personal computer (PC).
User will have complete access to the PLC inputs and can control the instruments
connected to PLC through graphical user interface (GUI).

To support the interoperability of supervisory control software (GUI) with
hardware (PLC), Object Linking and Embedding for Process Control (OPC) Server,
based on the Microsoft’s component object model (COM) is used. COM allows two
or more components to pass request and data with one another easily even if the
components are written in different programming languages and running on different
machines (Sherlock & Cronin, 2000) (Endi, Elhalwagy, & Hashad, 2010).

Object Linking and Embedding (OLE) 1.0 was developed by Microsoft© in
1990, replacing dynamic data exchange (DDE) (Ferguson, 2009). OLE allows
embedding and linking of documents. HMI allow user to control and monitor PL.C
process remotely. By linking the PLC data with personal computer (PC) using Object
Linking and Embedding (OLE), user can interact with PLC through interface on PC
to give instruction or input.



2.4 Applications and Recent Development

PLC with supervisory control has been implemented into various field of
industry such in water treatment plant, water supply distribution, power generation,
agriculture and many more (Firoozshasi, 2010} (Jianyan, Lin , & Meiping, 2010)
(Chang, Chang, Chou, & Wang, 2010). With supervisory control, PLC can provide a
real-time monitoring and control in a remote workstation such as central command

roomi.

In sewage treatment field, PL.C has played an important role in their control
system (Zhang, Wang , Yan, & Zhang, 2010). The sewage treatment becomes more
challenging proportionally with development of a city. This is due to the water
pollution problems becomes more serious as the city grow. As well as water
treatment in a gas refinery, as the plant growth, the need of good water treatment
system at the same time to keep operational costs low is demanding. Water treatment
processes are often difficult to handle due to various physical, chemical and

biological variables (Firoozshasi, 2010).

PLC based process monitoring and control system for industrial fuel alcohol
production process has been implemented in Heilongjiang Hua Run Incorporated
(China’s largest producer of alcohol) since year 2000 (Qiang, Gao, & Zhuang, 2002).
It uses WinCC as HMT host to produce GUI for the PL.C. PLC-based monitoring and
control implementation has significantly inecrease profit margin and process

reliability of the plant.

In agricultural field of study, supervisory control using PLC also has been
widely used to facilitate its automation needs. One example is steam-pretreated
process for Agriculture Wasted Reuses (Chang, Chang, Chou, & Wang, 2010).
Steam-pretreated process is a technique for the treatment of lignocelluloses raw
material. By adapting GUI-based monitoring and control function, the process is
significantly cost-effective and provides user friendly and reliable interaction to

operators.



CHAPTER 3

METHODOLOGY

3.1 Procedure Identification
( Start )

Do Research

Design the Process

r

Build Ladder Diagram -

is PLC Working?

Plan Graphicai User Interface (GUI)

b J

Buitd GUI using LabVIEW

Is GUI Working?

l Yes

Interfacing PLC with LabVIEW <+

is the

Interface Valid?

Figure 1: Procedure identification



To conduct this project, preliminary research is done using resources such as
library books, technical rescarch journal, and websites. This includes understanding
Lubetech process plant, learning the PLC programming language and performing
LabVIEW tutorials, which helps understanding the process and software that will be
used. After that, lubricant-transferring process will be designed to simulate

Lubetech’s plant process.

Next step is to construct ladder logic diagram for the process using CX
Programmer. This ladder logic diagram is based on the process designed on the
previous step. The contacts and coils addressing of the programming is referred to
OMRON CQM1H PLC.

After that, a GUI modeled from the Lubetech plant was developed to deliver
inputs and receive outputs from PLC. The GUI was built by using G-programming
which is consisting of block diagram and front panel elements. The GUI then linked
with PLC programming via OPC server and OPC client tool. Finished GUI allows
supervisory control for the plant.

Lastly, a series of software development, trial and improvements is made
regularly to perfecting the remote monitoring interface by using LabVIEW. The

procedure identification for this project is shown in Figure 1.
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3.3 Gantt Chart Semester 2
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3.4 OPC Linking Procedure

Before developing the GUI, linkage between PLC and LabVIEW need to be
tested in order to validate its connectivity through NI OPC server. To make PLC able
to receive signal from software button, the input addresses from ladder logic diagram
must be in HR, which is a “software” relay. Figure 2 shows a simple ladder program
that was used to test the PLC and LabVIEW connectivity.

" HRO.8S 18800

Figure 2: Ladder diagram with a holding relay

After that, a new project is created in NI OPC server window and added a
new channel as a new communication medium between OPC server and PLC. In the

channel configuration popup, parameters as in Table 1 are being assigned.

Channel Name RS-232

Device Driver Omron Host Link

Diagnostics Disabled
Communication Parameters

Serial 1D COM 1

Baud Rate 9600

Data Bits 7

Parity Even

Stop Bits 2

Flow Control None

Report Errors Yes

Optimization Method | Write only latest value for all tags

Duty Cycle Perform 10 writes for every 1 read

Tabie 1: Channel configuration

Next step, a new device is added in OPC server. The device represents PLC

which the server will communicate. The PLC can be added using New Device

i1




Wizard. Table 2 shows the summary of configuration made for the device used in
this project which is OMRON CQM1H-CPU21.

Device Name OMRONforFYP
Device Model CQM1

Device ID 0 (Decimal)

Connect Timeout 3s

Request Timeout 1000ms

Fail After 3 successive timeouts
Inter-request delay Oms

Enable auto device demotion | No

Intercharacter delay Oms

Table 2: Device configuration

After finished creating a device, next is adding tags into OPC server. A tag
represents addresses within the PLC or other hardware device that the server
communicates with. Figure 3 shows the tag created that will represent HR0.00
from the previous ladder diagram.
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Figure 2: Tag Properties window
Then, OPC Quick Client is being opened by opening Tools>OPC Quick

Client in OPC server window to check the signal quality from the PL.C. The signal
quality column in OPC Quick Client for the tag created should display “Good” as

12



shown in Figure 4 indicating the OPC server now ready to receive and send signal to

the PLC.
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Figure 4: OPC Quick Client window

In LabVIEW windows, a new project is being created to linking the tag from
OPC server with control button in LabVIEW front panel by opening
File>New>Project>Empty Project from LabVIEW window. After that, an OPC 1/O
server is added into the project by right click on My Computer>New>l/O Server as

shown in Figure 5 below.

Figure 5: Creating an I/0 server in LabVIEW project explorer
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In the I/O Server configuration, OPC Client was chose to be 1/O Server Type.
Table 3 shows the parameter of OPC Client I/O Server configurations.

Browse Machine
Machine localhost

Registered OPC servers | National Instruments NIOPCServers
Update rate 100ms
Deadband (%) 0

Table 3: OPC Client I/0 Server configuration

Next, a new library is added into the project by opening File>New>Other
Files>Library from the project window. After created the library, the tag created in
OPC Server is added into the new library by right click on the new library>Create
Bound Variables. The tag was added by clicking the Add™>> bution in the Create

Bound Variables window as shown in Figure 6.

oo . e . N T R O ~ - :._._._AT..__:_.__._._,.:....:...._......_._._..“:_ '

Figure 6: Create Bound Variable window

A blank VI is added into the project after that by opening
File>New>VI>Blank VI from the project window. From the LabVIEW Project
Explorer, the variable created can be dragged into the Blank VI to be used to control
the PLC using interface that will be developed.

14



3.5 Software and Tool

There are several softwarc and tools that will be used throughout the
development of this project. The software will be used to develop ladder logic
diagram and supervisory control interface while the tool is used to run the actual

testing and simulation.

3.5.1 CX Programmer 3.0
This software will be used to develop the ladder logic programming for
OMRON CQMI1H CPU21 programmable logic controller.

3.5.2 LabVIEW 8.6 Evaluation

Remote monitoring software is programmed and builds using LabVIEW 8.6.
Several toolkits such as Data Logging and Supervisory Control (DCS) module and
OPC Server also needed to complete the interfacing between PLC and LabVIEW.

3.5.3 OMRON CQM1H CPU21 PLC Training Kit

Real simulation and testing are done using CQMI1H programmable logic

controller.

15



CHAPTER 4

RESULTS AND DISCUSSIONS

4.1 Ladder diagram

A ladder programming for this project was developed in two phases, which
are hardware-ready and software-ready. In hardware-ready, the PLC instruction was
programmed to receive input from hardware device such as push button and limit
switches. This phase enables author to check the PLC instruction validity on
hardware before proceed to the software phase (interfacing).

Afier hardware-ready programming has been validated, PLC instruction will
be modified to receive input from software-build button. The modifications made
were at input addresses. The addresses of hardware input devices were changed into
holding relay (HR) addresses to allow user to interact with PLC using LabVIEW
software button. Figure 7 shows an abstract from the software phase ladder diagram.

Program Mame  NewProgram |

[Section Naee : Scction! |
000 HRO.00 | HR Sysicm
(000000} t = {O— ovorr

Glohal ON <HROD.00>
2002 2005 3100

HAODO  HR215 HRO.G2 | MR Holding Sun

D000 |
A -0— « >
e o an
ONOFF
oooaz | MRD00 5
m;’—l | f'ﬁ r_:"
HR Sysiem  LStop
ONORY
p———T (] WAOOO | FIR (BT Resdy
onooas) (— + O <Hronos>
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HAD.04 B12 R
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ey et 045 4053 b1
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b0s3
a0
S SW
{ Ao/ Nan
wal)

Figure 7: Extract of software-phase Ladder diagram

16



4.2 Object Linking and Embedding for Process Control (OPC)

Before proceed to the development of program interface, author has done a
simple simulation to test the connectivity of LabVIEW interface with PLC. The
testing was performed by creating a simple block diagram on a new LabVIEW
Virtual Instrument (VI) window that would energize PLC output when soft button on
screen is clicked. The association between soft button and PLC was linked using
OPC server and OPC client tools. The linking is successful if the PLC output
responds when the soft button is toggled. Figure 8 shows the Front Panel setup to test
connection functionality between LabVIEW and PLC.

Figure 8: Testing linking functionality

4.3 Front Panel Interface

The front panel of GUI for this project needs to be user-friendly as it is where
the interaction between Lubetech’s operators and instruments occurs. For this
project, author chooses to imitate Lubetech’s current MIMIC diagram and use it as
the main page of the interface as shown in Figure 9. It is because the operator already
familiar with current layout of the plant. The GUI designed has sets of buttons and
valves that are clickable to control plant operation. These buttons and valves have
similar function and behavior like a latched switch.

Author also decided to set apart the loader process and unloader process by
applying tabbed Ul Tabbed Ul is a feature to enhance operator’s control experience.

17



Figure 10 shows the loader and unloader control that are placed into different tab to

simplify the UI layout thus minimizing human error.
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Figure 10: Loader and unloader control placed on different tab.

4.4 PLC interface using LabVIEW

After completing the interface with fundamental elements, the GUI was ready
to be linked to PLC /O through NI OPC server tool. Full linking between software-
ready PLC program and GUI elements has been completed successfully. Figure 11
and 12 below show the project setup and signal quality from PLC addresses to OPC

quick client windows.
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Figure 11: PLC connected to GUL
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Figure 12: OPC quick client indicating good signal quality from PLC.

4.4 Additional Features

To make the program more reliable, there are several features that have been
considered to be included in the project such as security user login and history log
file. Security user login enables administrator to manage and limit the control actions
of the plant to the authorized personnel only. This feature is important to make sure

only authorized and competent persons are handling the plant operation.
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Figure 13: Security login popup.

Besides that, this system is capable to generate a dated history log file with
user logged-in. The system can log all activities by the user and can be retrieved at

any time for debugging and future reference.
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Figure 14: Dated history log with username.

20



CHAPTER 5

CONCLUSION AND RECOMMENDATIONS

5.1 Conclusion

The contribution of this project is creating a user-friendly interface to
remotely control and monitor lubricant blending process plant especially UMW
Lubetech by generating a LabVIEW-compatible PLC ladder programming. It also
provide cheaper alternative to distributed control system (DCS) for batch
processes. The important aspect of this project is comprehension of reading and
writing PLC memory through LabVIEW graphical programming language in order

to control the plant process.

The main objectives of this project had been successfully achieved. This
project enable user to monitor and control lubricant blending process on a screen. It
is also allow user to interact with field instruments through a PLC and host
computer. Remote control and monitoring software can save time to initiate process

and reduce safety risk in industrial environment.

This project has been presented and demonstrated to UMW Lubetech and
Lubetech authority has verified this project’s interlocking system to be similar to its

current process control.
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5.2 Recommendations

The GUI for this project can be further improved in the future. It can be
enhanced with a confirmation box feature and integrate it with process set point
input. Confirmation box feature would be nice to have since it will prevent
unintended action on the GUI as well as the plant process. This program also can be
improved by integrating it with transmitter to receive user set point for the process to

make it a complete integrated supervisory control for lubricant blending plant.

A major achievement of this project is when it is viable to be implemented
into UMW Lubetech plant as well as other lubricant blending plant. A more advance
programming may include an integration of inputs to control the PLC. This may

include Plug-and Play features for the software to be ready any time for any type of
PLC.
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INPUT

mment Address
sbal ON 0.00
|.SW (Auto/Manual) 0.01
'1 Fuse 0.02
vel KH1 0.03
vel KH2 0.04
vel KH3 0.05
vel KH4 0.06
vel KH5 0.07
vel BH1 0.08
/el BH2 0.09
el BH3 0.10
el BH4 0.11
el BHS 0.12
vel BH6 0.13
vel BH7 0.14
itop 0.15
p (BT1) 1.00
wp (BP2) 1.01
p (BP3) 1.02
p (BP4) 1.03
»p (BP5) 1.04
M1 1.05
M5 1.06
‘M3 1.07
‘M4 1.08
‘M10 1.09
|.SW (Auto:BP1) 3.01
|.SW (Auto:BP2) 3.02
|.SW ((Auto:BP3) 3.03
|.SW ((Auto:BP4) 3.04
|.SW (Auto:BP5) 3.05
|.SW (Manual:BP1) 3.06
|.SW (Manual:BP2) 3.07
|.SW (Manual:BP3) 3.08
|.SW (Manual:BP4) 3.09
|.SW (Manual:BP5) 3.10
OUTPUT
mment Address
1 100.00
1 100.01
2 100.02
3 100.03
4 100.04
S 100.05
fiF1-2 100.09
AF2-2 100.10
AF3-2 100.11
AF4-2 100.12
‘85 100.13
87 100.14

89 100.15



mment Address
HRO0.00
! System ON/OFF moi
| Loader Ready i
! Holding Start .
sk HRO.04
s HRO.05
L i HR0.06
O HR0.07
! (SK1 Ready) tes
g st HRO0.09
T HRO.11
: HRO.12
" HRO.13
” HRO.14
. HRO.15
. HR1.00
s HR1.01
ki HR1.02
el HR1.03
[ BT4 i
ke HR1.056
boom HR1.06
s HR2.01
n.SW (BV11) -
h HR2.03
n.SW (BV17) s
i HR2.05
1.SW (BV23) fts
e HR2.07
P HR2.08
s HR2.09
e HR2.10
o HR2.11
- HR2.12
R HR2.13
1L.SW (BV34) e
b HR2.15
" HR3.00
- HR10.01
B HR10.02
i HR10.03
et HR10.04
e HR10.05
R HR10.06
B HR10.07
2 HR11.01
! (Auto:BP1) -
: i HR11.03
t (Auto:BP2) e
! (Manual:BP2) iy
! (Auto:BP3) i
! (Manual:BP3) ko
: {(Mmmsp‘) HR11.08
: . HR11.09
Ry HR11.10
! (Manual:BPS) o
-+ HR12.01
'50



40
59
57
76
t (BP2)
51
41
50

1t (BP3)
52
42
B1
59
78
it (BP4)
53
43
91
70
79
t (BPS)

13
14
39
40
BP1
BP2
BP3
BP4
BPS

HR12.02
HR12.03
HR12.04
HR12.05
HR12.10
HR12.11

HR12.12
HR12.13
HR12.14
HR12.15
HR13.00
HR13.01

HR13.02
HR13.03
HR13.04
HR13.06
HR13.10
HR13.11

HR13.12
HR13.13
HR13.14
HR13.15
HR14.00
HR14.01

HR14.02
HR14.03
HR14.05
HR14.06
HR14.07
HR14.08
HR20.01

HR20.02

HR20.03
HR20.04
HR20.05



13)

18)

[Program Name : NewProgram1]

|Section Name : Section]]

ual)

0.00 HR0.00
r e O
Global ON

HR0.00 HR2.15 HRO0.02
—— —— | —0
HR System Start BTN
ON/OFF

HR0.00 0.15 IL

}‘ > T (02

HR System E.Stop
ON/OFF

HR2.01 0.08 HR0.03

| | T~
l I O

Lim. SW el BHI
(BV11)

0.01
Sel. SW
(Auto/Man
ual)

HR2.03 0.09 HRO.04
— - O
Lim SW el BH2
(BV17)

0.01
Sel SW
(Auto/Man
ual)

HR2.05 0.10 HRO0.05

| I O—-—-——
Lim SW el BH3
(BV23)

0.01
Sel. SW
(Auto/Man
ual)

HR2.07 0.1 HR{(‘)\.DG
— ——£ B
Lim.SW Level BH4
(BV29)

0.01
Sel SW
(Auto/Man

HR System
ON/OFF
<HR00.00>
a002 a005 a100

HR Holding Start
<HR00.02>
al0l

HR (BT1 Ready)
<HR00.03>
a044 b052 b060
b068 b076 b084
b092

HR (BT2 Ready)
<HR00.04 >
b045 a053 b061
b069 b077 b085
b093

HR (BT3 Ready)
<HR00.05>
b046 b054 a062
b070 b078 b086
b094

HR (BT4 Ready)
<HR00.06>
b047 b055 b063
a071 b079 b087
b095
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12
52)

13
30)

HR2.09

o
-
N

. HRO.07
3t O—

Lim SW el BH5
(BV30)

0.01
Sel.SW
(Auto/Man
ual)

HR2.11 0.13 HRO.08
— A —

Lim SW el BH6
(BV33)

0.01
Sel.SW
(Auto/Man
ual)

HR2.13 D.14 HRO.09
— —T=HE O—
Lim SW el BH?

(BV34)

0.01
Sel. SW
(Auto/Man
ual)

ILC

(03)

HRO0.03 HRO.04 HRO.05 HRO0.06 HR0.07 HRO.08 HRO0.09 HR1.00
- A -

HR (BTI HR(BT2 HR(BT3 HR(BT4 HR(SKl HR(SK2 HR(SK3
Ready) Ready) Ready) Ready) Ready) Ready) Ready)

HR0.03 HRO.04 HRD.05 HRO0.08 HRO0.07 HR0.08 HRO0.08 HR1.01

t o - 1 ! f 7 oo

HR(BTI HR(BT2 HR(BT3 HR(BT4 HR(SKI HR(SK2 HR(SK3
Ready) Ready) Ready) Ready) Ready) Ready) Ready)

HR0.03 HRO0.04 HR0.05 HRO0.06 HR0.07 HRO.08 HR0.09 HR1.02
g vl : . 4+ O
HR(BTI HR(BT2 HR(BT3 HR(BT4 HR(SKI HR(SK2 HR(SK3
Ready) Ready) Ready) Ready) Ready) Ready) Ready)

HR0.03 HRO.04 HRO0.05 HRO.06 HRO.07 HR0.08 HR0.09 HR1.03

I ,Ir’lL O_‘

HR(BTI HR(BT2 HR(BT3 HR(BT4 HR(SKI HR(SK2 HR(SK3
Ready) Ready) Ready) Ready) Ready) Ready) Ready)

HRO0.03 HRO.04 HR0.05 HF?O.DB H#lio.ll'ﬂ’ HI?D.OB HRO0.09 HR1.04

| |

HR(BTI HR(BT2 HR {BITB HR (B:T 4 HR(SKI HR(SK2 HR (S'K3
Ready) ~ Ready)  Ready)  Ready)  Ready)  Ready)  Ready)

HRO.03 HRO.04 HRO0.06 HRO0.08 HRO.07 HRO.08 HRO.08 HR1.05

— A | ——F -O

HR(BTI HR(BT2 HR(BT3 HR(BT4 HR(SK! HR(SK2 HR(SK3
Ready) ~ Ready)  Ready)  Ready)  Ready)  Ready)  Ready)

HRO.03 HRO.04 HRO0.05 HE:‘EG H?D.D? HRO0.08 HRDAIOD HR1.06
HR (BTI HR(BT2 HR {B[T3 HR (BlT4 HR (SKI HR(SK2 HR (SIK3
Ready) Ready) Ready) Ready) Ready) Ready) Ready)

HR (SK1 Ready)
<HR00.07>
b048 b056 b064
b072 a080 b088
b096

HR (SK2 Ready)
<HR00.08>
b049 b057 b065
b073 b081 a089
b0g7

HR (SK3 Ready)
<HR00.09>
b050 b058 b066
b074 b082 b090
a098

INT BTI

<HR01.00>
al02

INT BT2

| <HR01.01>

alo3

INT BT3
<HR01.02>
alo4

INT BT4
<HR01.03>
alos

INT SKI

<HRO1.04>
al06

INT SK2
<HR01.05>
al07

INT SK3

<HR0O1.06>
al08



|9
12)

HR0O.00  HR0.0Z  HR1.00 0.02 HR3.00
L 1
’“‘4 I 1 F C)—“_‘
HR System HR BTl  [UPI Fuse
ON/OFF  Holding
Start
HR1.01
L ._{ I_._ 4
INT BT2
HR1.02
' e | '
BT3
HR1.03
L _._i l_ 4
INT BT4
HR1.04
|- .__4 I_ 4
[INT SK 1
HR1.05
L .__| }_ J
INT SK2
HR1.06
L |_ x
INT SK3
HR3.00 100.00
Ry O—
hr UP1
008 HR2.02
| 1
Level BHI -
0.09 HR2.04
| 'Y
I
Level BH2 g
010 HR2.06
| S
Level BH3 =
0.1: HR2.08
L)
' I
Level BH4 e
0.1[2 HR2.10
i\
| I S
Level BHS
0.1L HR2.12
I S
Level BH6
0.14 HR2.14
L I\
NS

1
Level BH7

hr UPI

<HR03.00>

all2

UP1

HL BTI

HLBT2

HL BT3

HL BT4

HL SKI

HL SK2

HL SK3



L

[Program Name - NewProgram|]

|Section Name : Section2]

0.00 0.15 IL
t i ©
Global ON E.Stop
HR12.01 HR12.02 HR12.03 HR12.04 HR12.05 TiMo02 HR10.01
& 4 3 4+ O
KV50 KV40 KV59 KV67 KV76
HR12.01 HR12.02 HR12.03 HR12.04 HR12.05 TIMOD1
e (g | 1
f 1.0 T
KV350 KV40 KV59 KV67 KV76
HR12.01 HR12.02 HR12.03 HR12.04 HR12.05 TIM003
KV50 KV40 KV59 KV67 KV76
HR12.01 HR12.02 HR12.03 HR12.04 HR12.05 TIMOO4
I | =
I I T
KV50 KV40 KV59 KVe67 KV76
HR12.01 HR12.02 HR12.03 HR12.04 HR12.05 TIMO05
| [ s
I I i [ T
KV50 KV40 KV59 KV67 KV76
HR12.11 HR12.12 HR12.13 HR]12.14 HR12.15 TiM002 HR10.06 HR10.02
| L
I I I
KVs5i KV41 KV60 KVé6s KV77
BT2/SK1
cady)
HR12.11 HR12.12 HR12.13 HR12.14 HR12.15 TIMOO1
KV51 KV4) KV60 KV68 KV77
HR12.11 HR12.12 HR12.13 HR’12.14 HR12.15 TIMO03
e |
T 1 T T
KV5l1 KV41 KV60 KV6s KV77
HR12.11 HR12.12 HR12.13 HR12.14 HR12.15 TiMo04
KV51 KV41 KV60 KV68 KV77
HR12.11 HR12.12 HR12.13 HR12.14 HR12.15 TIMO005
KV51 KV41 KV60 KV68 KV77
HR13.01 HR13.02 HR13.03 HR13.04 HR13.05 TiM002 HR10.03
i | J£ | |
I T T . T T
KV52 KV42 KV61 KV69 KV78
HR13.01 HR13.02 HR13.03 HR13.04 HR13.05 TIMOO1
A o F
KVs2 Kv42 KVel KV69 KV78
HR13.01 HR13.02 HR13.03 HR13.04 HR13.05 TIM003
N5l | | & =
I | . I P il | 1
KV52 KV42 KV61 KV69 KV78
HR13.01 HR13.02 HR13.03 HR,13104 HR|13.05 TIMOO4
|
I I 1.
KV5s2 KV42 KVé61 KV69 KV78
HR13.01 HR13.02 HR13.03 HR13.04 HR13.05 TIMO05
| 1A | 1 |
I I L) T
KV52 KVv42 KV61 KV69 KV78

HR (BP] Ready)
<HR10.01>
a365

HR (BP2 Ready)
<HR10.02>
a370

HR (BP3 Ready)
<HR10.03>
a37s



o~

HR13.11 HR13.12 HR13.13 HR13.14 HR13.15 TIM002 HR10.04
o W 3+ 1 } ; - a2 O
KVs3 KV43 KV91 KV70 KV79
HR13.11 HR13.12 HR13.13 HR13.14 HR13.15 TIM0O01
KV53 KV43 KV9l1 KV70 KV79
HR13.11 HR13.12 HR13.13 HR13.14 HR13.15 TIM0O03
KVs53 KV43 KV91 KV70 KV79
HR13.11 HR13.12 HR13.13 HR13.14 HR113.15 TIMOO4
11
I L T
KV53 KVv43 KV91 KV70 KV79
HR13.11 HR13.12 HR13.13 HR13.14 HR13.15 TIM00S
1 1 } 4 { | +F i
KV353 KV43 KV91 KV70 KV79
HR14.01 HR1402 HR14.03 TIM002 HR10.07 HR10.05
L
I
KV86 KV8s8 KV90
(SK2/SK3
Ready)
HR14.01 HR14.02 HR14.03 TIM003
KV86 KV88 KV90
HR14.01 HR14.02 HR14.03 TiMO04
KV86 KV88 KV90
ILC
(03)
HR14.07 HR14.08 HR10.07
1 | e
I I 5,
BV39 BV40
HR14.07 HR14.08
BV39 BV40
HR14.05 HR14.06 HR10.06
I
I S
BV13 BVi4
HR14.05 HR14.06
BVI3 BVi4
0.03 TIM
=
KH1 001
#30
0.04 ™
..._...‘ !_
KH2 002
#30
0.05 T™M
— +
KH3 003
#30
0.06 Tim
= |
KH4 004
#30

HR (BP4 Ready)

<HR10.04>
a380

HR (BP5 Ready)
<HR10.05>
a385

HR (SK2/SK3
Ready)
<HR10.07>
a287

HR (BT2/SK1
Ready)
<HR10.06>
a201

[OP1]

| <TIMOO1(bit)>

b143 b178 b214
b249

[OP2]
[OP1]

[| <TIMO02(bit)>

b137 b172 b208
b243 b276
[OP2]

[OP1]

| <TIMOO3(bit)>

b150 b185 b221
b256 b280

[OP2]
[OP1]

[| <TIMOO4(bit)>

b157 b192 b228
b263b285

[OP2]



3“

TIM
-
KHS 005
#30
0.01 HR12.00 1.00 HR11.01
f i | 4 f—
Sel. SW Start (BT1) Stop (BT1)
(Auto/Man
ual)
3.02 HR12.10 1.01 HR11.03
o 1
Sel SW Start (BP2) Stop (BP2)
(Auto:BP2
)
3.03 HR13.00 1.02 HR11.05
—— ——F -O
Sel SW Start (BP3) Stop (BP3)
((Auto:BP
3)
3.04 HR13.10 1.03 HR11.07
11 | P
T 11 § S
Sel SW Start (BP4) Stop (BP4)
((Auto:BP
4)
305  HR1400  1.04 HR11.09
J O""'_
Sel. SW Start (BP5) Stop (BPS)
(Auto:BP3
)
0.01 HR12.00 1.00 HR11.02
3 O—
Sel SW tart (BT1) [Stop (BT1)
(Auto/Man
ual)
HR11.02
HR
(Manual-B
Pl)
3.07 HR12.10 1.01 HR11.04
: O
Sel. SW tart (BP2) [Stop (BP2)
(Manual B
P2)
HR11.04
HR
(Manual:B
P2)
3.08 HR13.00 1.02 HR11.06
f -
Sel SW tart (BP3) [Stop (BP3)
(Manual:B
P3)
HR11.06
HR
(Manual B
P3)
3.09 HR13.10 1.03 HR11.08
T
Sel.SW tart (BP4) (Stop (BP4)
(Manual:B
P4)
HR11.08
HR
(Manual B

P4)

[OP1]

1 <TIMO0OS(bit)>

b164 b199 b235
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[OP2]

HR (Auto:BP1)
<HR11.01>
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HR (Auto:BP2)
<HR11.03>
a367

HR (Auto:BP3)
<HR11.05>
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HR (Auto:BP4)
<HR11.07>
a377
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<HR11.09>
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HR (Manual:BP1)
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HR (Manual:BP2)
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HR10.01
| L

HR20.01

HR (BPI
Ready)

1.06 HR10.02

HR20.02

1
HR '
(Auto:BP2
)
HR11.04
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HR20.01
I

HR (BP4
Ready)

1.08 HR10.05
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<HR20.01>
a387

HR BP2
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<HR20.03>
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HR BP4

<HR20.04>
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BP1
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<100.02>
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